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Environmental and Safety Consideration

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR,
chapter 1 Subchapter J for Class I(1) laser products, and elsewhere, is certified as a
Class I laser product conforming to the requirements of IEC 825.

Class I laser products are not considered to be hazardous. The laser system and
printer are designed so there is never any human access to laser radiation above a
Class I level during normal operation, user maintenance, or prescribed service
condition.

WARNING

Never operate or service the printer with the protective cover removed from Laser/
Scanner assembly. The reflected beam, although invisible, can damage your eyes.
When using this product, these basic safety precautions should always be followed to
reduce risk of fire, electric shock, and injury to persons:

CAUTION - INVISIBLE LASER RADIATION
WHEN THIS COVER OPEN.
DO NOT OPEN THIS COVER.
VORSICHT - UNSICHTBARE LASERSTRAHLUNG,
WENN ABDECKUNG GEOFFNET.
NICHT DEM STRAHL AUSSETZEN.

ATTENTION - RAYONNEMENT LASER INVISIBLE EN CAS
D’OUVERTURE. EXPOSITION DANGEREUSE
AU FAISCEAU.

ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI
APERTURA. EVITARE LESPOSIZIONE AL FASCIO.

PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE.
EVITAR EXPONERSE AL RAYO.

PERIGO - RADIAGAO LASER INVISIVEL AO ABRIR. EVITE
EXPOSICAO DIRECTA AO FEIXE.

GEVAAR - ONZICHTBARE LASERSTRALEN BlJ GEOPENDE
KLEP. DEZE KLEP NIET OPENEN.

ADVARSEL. - USYNLIG LASERSTRALNING VED ABNING, NAR
SIKKERHEDSBRYDERE ER UDE AF FUNKTION.
UNDGA UDSAETTELSE FOR STRALNING.

ADVARSEL. - USYNLIG LASERSTRALNING NAR DEKSEL
APNES. STIRR IKKE INN | STRALEN. UNNGA
EKSPONERING FOR STRALEN.

VARNING - OSYNLIG LASERSTRALNING NAR DENNA DEL
AR OPPEN OCH SPARREN AR URKOPPLAD.
BETRAKTA EJ STRALEN. STRALEN AR FARLIG.
VARO! - AVATTAESSA JA SUOJALUKITUS OHITETTAESSA

OLET ALTTIINA NAKYMATTOMALLE LASER-
SATEILYLLE ALA KATSO SATEESEEN.

£ OB - FRBFUE LRRLEENG
o - ol WHS 2 EolxBo| LB 4+ o=
FoAI2.
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Ozone Safety

During normal operation, this machine produces ozone. The
ozone produced does not present a hazard to the operator.
However, it is advisable that the machine be operated in a well
ventilated area.

If you need additional information about ozone, please contact
your nearest Samsung dealer.

Power Saver
This printer contains advanced energy conservation
technology that reduces power consumption when it is not
in active use.
When the printer does not receive data for an extended

period of time, power consumption is automatically
lowered.

The energy star emblem does not represent EPA
endorsement of any product or service.

Recycling

@ Please recycle or dispose of the packaging material for this

% product in an environmentally responsible manner.
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Radio Frequency Emissions

FCC regulations

This device has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

1 Reposition the receiving antenna.
2 Increase the separation between the equipment and receiver.

3 Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

4 Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications not expressly approved by the manufacturer
responsible for compliance could void the user’s authority to operate the equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur:
“Appareils Numériques”, ICES-003 édictée par I'Industrie et Sciences Canada.



Declaration of Conformity (European Countries)

Approvals and Certifications

The CE marking applied to this product symbolizes Samsung
Electronics Co., Ltd. Declaration of Conformity with the following
applicable 93/68/EEC Directives of the European Union as of the
dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the
member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of the
laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and
telecommunications terminal equipment and the mutual recognition of their
conformity.

A full declaration, defining the relevant Directives and referenced standards can be
obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment &
Telecommunications Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single
terminal connection to the analogue public switched telephone network (PSTN) in
accordance with Directive 1999/5/EC. The product has been designed to work with
the national PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics
Co., Ltd. in the first instance.

The product has been tested against TBR21 and/or TBR 38. To assist in the use and
application of terminal equipment which complies with this standard, the European
Telecommunication Standards Institute (ETSI) has issued an advisory document (EG
201 121) which contains notes and additional requirements to ensure network
compatibility of TBR21 terminals. The product has been designed against, and is fully
compliant with, all of the relevant advisory notes contained in this document.



EU Declaration of Conformity (LVD,EMC)

For the following product :

Laser Beam Printer

(Product name)

ML-1710, ML-1510, Phaser 3115, Phaser 3120

(Model Number)

Manufactured at :

Samsung Electronics Co.,Ltd #259. GongDan-Dong,Gumi-Shi, GyungBuk, KOREA 730-030

Shandong Samsung Telecommunications Co., Ltd. Sanxing Road, Weihai Hi-Tech, IDZ Shandong
Province, 264 209, China

(factory name, address)

We hereby declare, that all major safety requirements, concerning to CE Marking
Directive[93/68/EEC] and Low Voltage Directive [73/23/EEC], ElectroMagnetic
Compatibility [89/336/EEC], amendments [92/31/EEC] are fulfilled, as laid out in the
guideline set down by the member states of the EEC Commission.

This declaration is valid for all samples that are part of this declaration, which are
manufactured according to the production charts appendix.

The standards relevant for the evaluation of safety & EMC requirements are as

LVD : EN 60950:2000, EN 60825-1:1994,A11:1996

EMC : EN 55022:1998, EN 61000-3-2:1995 inc+A1+A2:1998+A14:2000
EN61000-3-3:1995,EN 55024:1998

follows :
1. Certificate of conformity / Test report issued by :

LVD : TUV Rheinland
EMC : SAMSUNG Electronics EURO Q.A. Lab. in the U.K.

2. Technical documentation kept at :

Samsung Electronics Co.,Ltd

which will be made available upon request.
(Manufacturer)

Samsung Electronics co.,ltd

#259,KongDan-Dong,GuMi-City /\’a; - =
KyungBuk, Korea 730-030 -3

2003-03-25
Whan-Soon Yim / Senior Manager

(place and date of issue) (name and signature of authorized person)

(Representative in the EU)

Samsung Electronics Euro QA Lab. i e "]L

Blackbushe Business Park,Saxony Way, ’f/%-_ 7

Yateley, Hampshire,GU46 6GG, UK V /’/
2003-0325

In-Seop Lee / Manager

(place and date of issue) (name and signature of authorized person)

WARNING

¢ Do not disassemble the printer. Doing so may give you an electric shock.

e If you continuously print many pages, the surface of the output tray may become
hot. Be careful not to touch the surface, especially for children.
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INTRODUCTION

Special Features

Your new printer is equipped with special features that improve
the print quality, giving you a competitive edge. You can:

Print with excellent quality and high speed
e You can print at 600 dots per inch (dpi). See page 4.16.

¢ Prints 17 pages-per-minute (Letter size),
16 pages-per-minute(A4 size).

Handle paper flexibly

¢ Standard 250-sheet tray and a 1-sheet Manual Feeder
support various sizes and types of paper.

¢ Two output trays; select either the top output tray (face-
down) or the rear output tray (face-up) for the most
convenient access.

Create professional documents

¢ You can customize your documents using Watermarks, such
as “Confidential.” See page 4.19.

¢ Print Posters. The text and pictures of each page of your
document are magnified and printed across the selected sheet
of paper. After the document has printed, trim off the white
edges of each sheet. Tape the sheets together to form a
poster. See page 4.14.
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UNIVERSAL SERIAL BUS

Save your time and money

¢ Allows you to use the Toner Save mode to save toner. See
page 4.8.

» Allows you to print multiple pages on one single sheet of paper
to save paper (N-Up printing). See page 4.10.

¢ This printer meets Energy Star guidelines for energy
efficiency.

Print in various environments
¢ You can print in Windows 95/98/Me/NT 4.0/2000/XP.
e Your printer is compatible with Linux and Macintosh.

¢ Your printer comes with both the Parallel and the USB
interface.
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Printer Components

Front View

Output Support
— Top output tray
/ (Face down)

Control Panel

Cover

Power switch

Manual Feeder guide T
Tray I

Manual Feeder

ﬂ

Paper level indicator

.

M
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Inside View

Toner cartridge =g

Front Cover

Rear View

Rear output tray
(Face up)

j >

<)
Ty

Power receptacle

Parallel port
USB port
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Understanding the Control Panel

On Line/Error

@
@

Toner Save

O

Cancel

\_

On Line/Error and Toner Save LEDs

LED Description

If the On Line/Error lights green, the printer is ready to
On Lir%Error print.

If the On Line/Error lights red, the printer is experiencing
an error, such as jammed paper, the open cover or the empty
toner cartridge. See “Troubleshooting Error Messages” on
page 6.18.

If you press the Cancel button while the printer is receiving
data, the On Line/Error LED blinks red to cancel printing.

In Manual Feed mode, if there is no paper in the Manual
Feeder, the On Line/Error LED blinks red. Load paper into
the Manual Feeder and the LED stops blinking.

If the printer is receiving data, the On Line/Error LED
slowly blinks green.

If the printer is printing the received data, the On Line/
Error LED blinks green fast.

If you press the Cancel button in Ready mode, this LED is on
@ and the Toner Save mode is enabled.

Toner Save If you press this button once again, this LED is off and the

Toner Save mode is disabled.

BEXE inTrODUCTION



Description

If the On Line/Error and Toner Save LEDs blink, your
system has some problems. To solve the problem, see
“Troubleshooting Error Messages” on page 6.18.

On Line/Error

Toner Save

Cancel button

Function Description

Printing demo page | In Ready mode, press and hold this button for about 2
seconds until all LEDs blink slowly, and release.

Manual feeding Press this button each time you load a sheet of paper in the
manual feeder, when you select Manual Feed for Source
from your software application. For detailed information,
see “Using the Manual Feeder” on page 3.8.

Cleaning inside In Ready mode, press and hold this button for about 10
printer seconds until all LEDs turn on, and release. After cleaning
the printer, one cleaning sheet is printed.

Canceling print job | Press this button during printing. The On Line/Error LED
blinks while the print job is cleared from both the printer
and the computer, and then return to Ready mode. This
may take some time depending on the size of the print job.

In Manual Feed mode, you can’t cancel the print job by
pressing this button. For detailed information, see “Using
the Manual Feeder” on page 3.8.

Toner Save mode In Ready mode, press this button to turn the Toner Save
on/off mode on or off.
For detailed information, see page 4.8.

INTRODUCTION
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Setting Up Your Printer

This chapter provides step by step information on setting up
your printer.

This chapter includes:

e Unpacking

e Installing the Toner Cartridge
e Loading Paper

e Connecting a Printer Cable

e Turning the Printer on

e Printing a Demo Page

e Installing Printer Software



Unpacking

1 Remove the Printer and all accessories from the packing
carton. Make sure that the printer has been packed with the
following items:

Toner Cartridge Power Cord
CD-ROM Setup Guide

g Notes:

¢ If any items are missing or damaged, notify your dealer
immediately.

e Components may differ from one country to another.

¢ The CD-ROM contains the printer driver, the User’s Guide, and
the Adobe Acrobat Reader program.

2 Carefully remove all of packing tapes from the printer.

Tape

SETTING UP YOUR PRINTER



Selecting a Location

Select a level, stable place with adequate space for air
circulation. Allow extra space for opening covers and tray. The
area should be well-ventilated and away from direct sunlight or
sources of heat, cold, and humidity. See the image below for
clearance space. Do not place the printer close to the edge of
your desk or table!

Clearance
Space T VA — '

954.6 mm(37.5 in.)

*Front: 482.6 mm (enough space so that tray can be
removed)

eBack: 100 mm (enough space to allow opening of the rear
out tray)

*Right: 100 mm (enough space for ventilation)
eLeft: 100 mm

SETTING UP YOUR PRINTER P8¢



Installing the Toner Cartridge

1 Grasp the front cover and pull it toward you to open.

gNote: Because the printer is very light, it may be moved when you
use it; for example, when opening/closing the tray or installing/
removing the toner cartridge. Be careful not to move the printer.

2 Remove the toner cartridge from its bag and remove the
paper covering the cartridge.

3 Gently shake the cartridge from side to side to distribute
the toner evenly inside the cartridge.

CAUTION:

* To prevent damage, do not expose the toner cartridge to light for
more than a few minutes. Cover it with a piece of paper, if left
exposed for more than a few minutes.

e If toner gets on your clothing, wipe it off with a dry cloth and
wash clothing in cold water. Hot water sets toner into fabric.

SETTING UP YOUR PRINTER



4 Locate the cartridge slots inside the printer, one on each
side.

5 Grasp the handle and insert the cartridge in the printer until
it snaps into place.

6 Close the front cover. Make sure that the cover is securely
closed. If the cover is not firmly closed, printing errors may
occur when you print.

gNote: When printing text at 5% coverage, you can expect a toner
cartridge life of approximately 3,000 pages (1,000 pages for the
toner cartridge that is shipped with the printer).

SETTING UP YOUR PRINTER



Loading Paper

You can load approximately 250 sheets of paper in the tray.

1 Pull the tray out of the printer.

dNote: Because the printer is very light, it may be moved when you
use it; for example, when opening/closing the tray or installing/
removing the toner cartridge. Be careful not to move the printer.

2 Push down the pressure plate until it locks in position.

3 Prepare a stack of paper for loading by flexing or fanning
them back and forth. Straighten the edges on a level
surface.

BEXE) SETTING UP YOUR PRINTER



4 Load paper with the print side facing down.

Make sure that all four corners are flat in the tray.

5 Pay attention to the paper limit mark on the left inside wall
of the tray. Paper overloading may cause paper jams.

dNote: If you want to change the paper size in the tray, see
“Changing the Paper Size in the Tray” on page 2.8.

6 Slide the tray back into the printer.

SETTING UP YOUR PRINTER



Changing the Paper Size in the Tray

1 Pinch the rear guide as shown below to adjust for the paper
length.

2 Pinch the side guide as shown and slide it to the left flush
against the paper.

g Notes:

¢ Do not push the width guide far enough to cause the material to
warp.

¢ If you do not adjust the width guide, it may cause paper jam.

v I X || X

= = |==h
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Connecting a Printer Cable

To print from your computer, you need to connect your printer
to your computer with either a parallel interface cable or a
Universal Serial Bus (USB) cable.

If you are a Macintosh user, you can use only a USB cable.

Using a Parallel Cable

Note: To connect the printer to the parallel port of the computer
requires a certified parallel cable. You will need to buy a IEEE1284
compliant cable.

1 Make sure that both the printer and the computer are
turned off.

2 Plug the parallel printer cable into the connector on the
back of the printer.

Push the metal clips down to fit inside the notches on the
cable plug.

To the parallel port
on your computer

3 Connect the other end of the cable to the parallel interface
port on your computer, and tighten the screws.

See your computer User’s Guide if you need help.

SETTING U Your PRINTER [JEIEN



Using a USB Cable

Note: Connecting the printer to the USB port of the computer
requires a certified USB cable. You will need to buy a USB 1.1
compliant cable that is within 3m in length.

1 Make sure that both the printer and the computer are
turned off.

2 Plug the USB printer cable into the connector on the back of
the printer.

To the USB port on
your computer

3 Connect the other end of the cable to the USB port on your
computer.

See your computer User’s Guide if you need help.

gNote: For using a USB cable, you must be running Windows 98/
Me/2000/XP, or Macintosh with OS 8.6 and the G3 processor or
higher.

SETTING UP YOUR PRINTER



Turning the Printer on

1 Plug the power cord into the power receptacle on the back
of the printer.

2 Plug the other end into a properly grounded AC outlet and
turn on the printer using the power switch.

To the AC outlet

CAUTION:

e The fusing area at the rear portion of the inside of your printer is
hot when powered. Be careful not to be burned when accessing
this area.

¢ Do not disassemble the printer when it is powered. Doing so may
give you an electric shock.

SETTING UP YOUR PRINTER



Printing a Demo Page
Print a demo page to make sure that the printer is operating
correctly.

1 Hold down the Cancel button for about 2 seconds to print a
demo page.

2 The Demo page shows the printer’s current configuration.

Pnususg

ML-1710
Monochrome Laser Printer
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Installing Printer Software

The supplied CD-ROM contains Windows printing software,
Macintosh printing software, Linux printing software, on-line
User’s Guide and Acrobat Reader to view the User’s Guide.

If you are printing from Windows

You can install the following printer software using the CD-ROM.

¢ Printer driver for windows. Use this driver to take full
advantage of your printer’s features. See page 2.15.

o Status Monitor allows you to see the printing status of the
printer. See page 4.26.

If you are printing from Macintosh
Go to “Using Your Printer with a Macintosh” on page 7.2, for

information about installing the print software and printing from
a Macintosh.

If you are printing in Linux

Go to “Using Your Printer in Linux” on page 7.10, for information
about installing the Linux driver.

SETTING UP YOUR PRINTER



Printer Driver Features

Your printer drivers will support the following standard features:
e Paper source selection
e Paper size, orientation and media type

e number of copies

Table below lists a general overview of features supported by
your printer drivers.

Printer Driver
Feature

Win9x/Me | Win2000/XP Macintosh
Toner Save Y Y Y N
Print quality option Y Y Y Y
Poster printing Y Y Y N
z/INu_IEIiF;)))Ie pages per sheet y y y y
Fit to page printing Y Y Y N
Scale printing Y Y Y Y
Watermark Y Y Y Y
Overlay Y Y Y N

SETTING UP YOUR PRINTER



Installing Printer software in Windows

System Requirements
Verify the following:

¢ At least 32 MB (Windows 9x/Me), 64 MB (Windows 2000/NT),
128 MB (Windows XP) or more of RAM is installed on your PC.

e There is at least 300 MB of free disk space on your PC.

o All applications are closed on your PC before beginning
installation.

* You have one of the following operating systems: Windows 95,
Windows 98, Windows Me, Windows NT 4.0, Windows 2000 or
Windows XP.

¢ Internet Explorer 5.0 or later.

Installing Printer Software

1 Place the CD-ROM in the CD-ROM drive. Installation will
start automatically.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type x:\Setup.exe
in the Open box (where x is the drive letter for the CD-ROM
drive), then click OK.

Note: If the New Hardware Found window appears during the

installation procedure, click X in the upper right corner of the box,
or click Cancel.

2 When the following window opens, connect your printer to
the computer and turn the printer on. Then click Next.

Samsung ML-1710 Series

Connect Samsung ML-1710 Series é’ P,

I you weant ta install Samsung ML-1710 Series properly vou have to connect Samsung
ML-1710 Series before ingtallation,

“Y'ou may connect the device using LPT or USE cable like on the figure. then tuin on the
power of Samsung ML-1710 Series

Cliclk [Mext »]

. Cancel

If the printer is already connected and turned on, this
screen does not appear. Skip to the next step.
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3 Choose the installation type.

Samszung ML-1710 Series

Welcome to Samsung ML-1710 Series Setup

Autornatically install all programs necessary
to use Samsung ML-1710 Series

Auto [nstall |Recommended)

Install the selected programs to uze

Custom Install Samsung ML-1710 Series

Provide a detailed description for inztallation
“iew User's and uzage of 5amsung ML-1710 Series
Guide

Cancel |

e Auto Install: Installs the common software for your
printer, such as printer driver, and User’s Guide. This is
recommeded for most users.

eCustom Install: Allows you to choose the language of the
software and the components you want to install. After
selecting the language and the component(s), click Next.

Samsung ML-1710 Series

Select comp to be i lled -

Select components ta be installed

— Select component:
[ Frinter
[l Status Monitor

< Back I Mext > I Cancel |

*View User’s Guide: Opens Samsung ML-1710 Series
User’s Guide. If your computer doesn’t have Adobe
Acrobat, click on this option and it will automatically install
Adobe Acrobat Reader for you.

4 After the installation is finished, the window asking you to
print a test page appears. If you want to print a test page,
select the checkbox and click Next.

Otherwise, just click Next and skip to step 6.
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5 When the test page prints out correctly, click Yes.

If not, click No to reprint it.

6 To register yourself as a user of Samsung Printers, select
the checkbox and click Finish. You are now accessed to the
Samsung web site.

Otherwise, just click Finish.

Samsung ML-1710 Series

Samsung ML-1710 Series Setup Complete

On-ine Registration
“Tou will get the oppartunity to receive free newsletters with
excluzive tips and promotions. Also you will get more customer

care.
‘Would you like ta register for the S amsung Printer
Membership?

Setup has finished instaling Samsung ML-1710 Series on your
COMmpLUber

NOTES:

* When you want to use your printer with the parallel cable,
remove the USB cable and connect the parallel cable. Then
repair the printer driver; select Start -~ Programs —» Samsung
ML-1710 Series — Printer Maintenance — Repair - Printer.
If you have replaced the parallel cable with the USB cable, do the
same to repair the driver.

o If your printer doesn’t work properly, reinstall the printer driver.
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Repairing the Printer software
Repair is required if your installation fails.
1 From the Start menu, select Programs.

2 Select Samsung ML-1710 Series and then Printer
Maintenance.

3 Select Repair and then click Next.

Samsung ML-1710 Series

Samsung ML-1710 Series Repair and
Remowve program.

Samsung ML-1710 Series program wil be repaired or
r\, re-installed if there iz zomething wrong.

e

© Remove

Remaove the installed 5amsung ML-1710 Series programs.

NOTE: If your printer is not connected to the computer, the
Connect Samsung ML-1710 Series window opens. After connecting
the printer, click Next.

4 Select the components you want to reinstall and click Next.

Samszung ML-1710 Series

Select components to be repaired or installed %

i~ Select Component:

7 Repair aor Install Printer.
A Status Monitar

< Back I Next > I Cancel

5 1If you select Printer, follow steps 4 and 5 on page 2.16.

6 When the reinstallation is done, click Finish.
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Removing the Printer software
1 From the Start menu, select Programs.

2 Select Samsung ML-1710 Series and then Printer
Driver Maintenence .

3 Select Remove and then click Next.
4 Select the components you want to remove and click Next.
5 When you are asked to confirm your selection, click OK.

6 Aftern the software is removed, click Finish.

Changing the Display Language

After installation of the software, you can change the display
language. If you installed the Status Monitor, the selected
language is applied to it.

1 From the Start menu, select Programs.

2 Select Samsung ML-1710 Series and Language
Selection.

3 Select the language you want from the language selection
window and click OK.

# Samsung ML-1710 Series (=]

- Selectthe language for Samsung

= . ;

g bL-1710 Series from the choices
below

Printer Driver
[Engtish =
Pemote Gantia) Pane]

| [
St fyl e

| [

Cancel
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Viewing the User’s Guide

After installing the printer software, you can view User’s Guide
in PDF format at any time from your Windows desktop.

1 From the Start menu, select Programs.

2 Select Samsung ML-1710 Series and View User’s
Guide.

Adobe Acrobat automatically runs and then the User’s Guide
opens.

gNOTE: If your computer doesn’t have Adobe Acrobat, selecting
the View User’s Guide option automatically installs Adobe
Acrobat for you. After installing is complete, repeats step 1 and 2.
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Using Print Materials

This chapter will help you understand types of paper you
can use with this printer and how to properly load paper in
the tray for the best print quality.

This chapter includes:

e Choosing Paper and Other Materials

e Selecting the Output Location

e Loading Paper

e Printing on Envelopes

e Printing on Labels

e Printing on Transparencies

e Printing on Card Stock or Custom-sized Materials

e Printing on Preprinted Paper



3.2

Choosing Paper and Other Materials

You can print on a variety of print materials, such as plain paper,
envelopes, labels, transparencies and so on. See “Paper
Specifications” on page 7.21. To get the best possible print
quality, use only high-quality copier-grade paper.

When you choose print materials, consider the followings:

¢ Desired outcome: The paper you choose should be
appropriate for the project.

¢ Size: You can use any size paper that fits easily within the
paper adjusters of the paper feeder.

o Weight: Your printer supports paper weight as follows:
e 16~24 |bs (60~90 g/m2) bond for the tray
¢ 16~43 |bs (60~163 g/m?) bond for the manual feeder

¢ Brightness: Some papers are whiter than others and produce
sharper, more vibrant images.

¢ Surface smoothness: The smoothness of the paper affects
how crisp the printing looks on the paper.

CAUTION: Using a material that does not conform to the
specification listed in the paper specification can cause problems
that may require service. This service is not covered by the
warranty or service agreements.
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Sizes and Capacities

Input Source/Capacity?

Tray Manual Feeder

Plain Paper
Letter (8.5 x 11 in.) 250
Legal (8.5 x 14 in.) 250
Executive (7.25 x 10.5in.) 250
Folio (8.5 x 13 in.) 250
A4 (210 x 297 mm) 250
B5 (182 x 257 mm) 250
A5 (148 x 210 mm) 250
A6 (105 x 148 mm) 250

e i

Envelopes®
No. 10 (4.12x 9.5 in.) -
Monarch (3.87 x 7.5 in.) -
C5 (162 x 229 mm) -
DL (110 x 220 mm) -
B5 (176 x 250 mm) -
C6 (114 x 162 mm) -

e e e e

Labels?
Letter (8.5 x 11 in.) - 1
A4 (210 x 297 mm) - 1

Transparencies®
Letter (8.5 x 11 in.) - 1
A4 (210 x 297 mm) - 1

Card stocks® - 1

a. Depending on paper thickness, the maximum capacity may be reduced.
b. If you are experiencing excessive jamming, feed one sheet at a time through the
manual feeder.
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3.4

Guidelines for Paper and Special Materials

When selecting or loading paper, envelopes, or other special
materials, keep these guidelines in mind:

o Attempting to print on damp, curled, wrinkled, or torn paper
can cause paper jams and poor print quality.

¢ Use cut-sheet paper only. You cannot use multi-part paper.

¢ Use only high-quality, copier grade paper for the best print
quality.

¢ Do not use paper that has been already printed on or that has
been fed through a photocopier.

¢ Do not use paper with irregularities, such as tabs or staples.

¢ Do not attempt to load any feeder during printing and never
overfill the feeder. This could cause a paper jam.

¢ Avoid paper with embossed lettering, perforations, or texture
that is too smooth or too rough.

¢ Colored paper should be of the same high quality as white
photocopy paper. The pigments must withstand the printer’s
fusing temperature of 400°F (205°C) for 0.1 second without
deterioration. Do not use paper with a colored coating that was
added after the paper was produced.

¢ Preprinted forms must be printed with nonflammable, heat-
resistant ink that do not melt, vaporize, or release hazardous
emissions when subject to the printer’s approximately 400°F
(205°C) fusing temperature for 0.1 second.

o Store paper in its ream wrapper until ready to use. Place
cartons on pallets or shelves, not on the floor.

¢ Do not place heavy objects on top of the paper, whether it is
packaged or unpackaged.

o Keep paper away from moisture, direct sunlight or other
conditions that can cause it to wrinkle or curl.
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Selecting the Output Location

The printer has two output locations: the rear output tray and
the top output tray.

VY Top output tray V¥ Rear output tray

To use the top output tray, be sure the rear output tray is closed.
To use the rear output tray, open it.

d Notes:

¢ If paper coming out of the top output tray has problems, such as
excessive curl, try printing to the rear output tray.

¢ To avoid paper jams, do not open or close the rear output tray
while the printer is printing.

Printing to the Top Output Tray (Face down)

The top output tray collects paper face-down, in correct order.
The top output tray should be used for most print jobs.

Note: If you continuously print many pages, the surface of the
output tray may become hot. Be careful not to touch the surface,
especially for children.
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Printing to the Rear Output Tray (Face up)

The printer always prints to the rear output tray if it is open.
Paper comes out of the printer face-up, and each time a sheet
of paper comes out, it falls down from the printer.

Printing from the Manual Feeder to the rear output tray provides
the straight paper path. Opening the rear output tray might
improve the output quality with the following:

¢ envelopes
o |abels
¢ transparencies

To open the rear output tray:

1 Open the rear door by pulling it down. The cover functions
as the output tray.

gNote: Please be careful when you open the rear cover. The inside
of the printer maybe hot.
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2 If you do not want to print to the rear output tray then close
the tray. The pages will stack on the top output tray.

Loading Paper

Proper paper loading helps prevent paper jams and ensure
trouble-free printing. Do not remove the tray while a job is
printing. Doing so may cause a paper jam. See “Sizes and
Capacities” on page 3.3 for acceptable paper size and capacities
for each tray.

The paper level bar on the front of the paper tray shows the
amount of paper currently in the tray. When the tray is empty,
the indicator of the bar is lowered.

Paper full A A Paper empty

Using the Tray

14

The tray holds 250 sheets of paper. See “Sizes and Capacities
on page 3.3 for acceptable paper size and capacities of each
tray.

Load a stack of paper into the tray and print. for details about
loading paper in the tray, see “Loading Paper” on page 2.6.
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Using the Manual Feeder

If you select Manual Feed in the Source option, you can
manually load paper in the manual feeder. Manually loading
paper can be helpful when you want to check the print quality
after each page is printed.

If you experience a paper jam from the tray, load one sheet of
paper at a time into the manual feeder.

1 Load the print material in the manual feeder with the print
side up.

Adjust the paper guide against the print material without
bending the paper.

2 When you print a document, you must select Manual Feed
for Source from the software application, and then select
the correct paper size and type. For details, see page 4.6.

3 Press the Cancel button on the printer to start feeding.
4 Printing is started.

5 If you are printing multiple pages, load the next sheet after
the first page prints out, and press the Cancel button.

Repeat this step for every page to be printed.
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In Manual Feed mode, you can’t cancel a print job by pressing
the Cancel button.

To cancel a print job in Manual Feed mode:

1 Turn the printer off.

2 Double-click the g icon at right bottom of the window.

Double-click this icon to view
the queue of the print jobs.

v
[BBYE & 323PM

3 Select a job you want to cancel.

&% Samsung ML-1710 Series [_[O] =]
Frinter Document  Yiew | Help

Document Mame | Status | Owner | Progress | Started At |
|#] Document Frinting buririus Obytes of 2. 320:43 PM 9/13/02
1 jobsz in queue 7z

4 For Windows 9x/Me, select Cancel Printing from
Document menu.

For Windows NT/2000/XP, select Cancel from Document
menu.

&" Samsung ML-1710 Series M= B
Printer | Document Miew  Help
Docum Pause Frinting | Status | Cwner | Progress | Started At |
Cancel Printing Printing buririus Obytesof 2., 320:43 PM 9413402

1 jobs in queus G

5 When the jobs are removed from the list. Turn the printer
on.
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Printing on Envelopes

Guidelines

o Only use envelopes recommended for laser printers. Before
loading envelopes in the manual feeder, make sure that they
are undamaged and are not stuck together.

* Do not feed stamped envelopes.

¢ Never use envelopes with clasps, snaps, windows, coated

lining, or self-stick adhesives. These envelopes may severely
damage the printer.

1 Open the rear output tray. Load the envelopes into the
manual feeder with the flap side down.

The stamp area is on the left side and the end of the
envelope with the stamp area enters the feeder first.
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3 When you print on envelopes, you must select Manual
Feed for Source from the software application, and then
select the correct paper size and type. For details, see
page 4.6.

4 Press the Cancel button to start feeding.

Note: Please be careful when you open the rear cover. The inside
of the printer maybe hot.

5 Printing is started. Close the rear output tray after the
printing is completed.
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Printing on Labels

Guidelines
¢ Only use labels recommended for laser printers.

« Verify that the labels’ adhesive material can tolerate fusing
temperature of 200°C (392°F) for 0.1 second.

o Make sure that there is no exposed adhesive material
between the labels. Exposed areas can cause labels to peel
off during printing, which can cause paper jams. Exposed
adhesive can also cause damage to printer components.

* Do not feed a sheet of label through the printer more than
once. The adhesive backing is designed for one pass through
the printer.

¢ Do not use labels that are separating from the backing sheet
or are wrinkled, bubbled, or otherwise damaged.

1 Open the rear output tray. Load labels in the manual feeder
with print side up.
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3 When you print on labels, you must select Manual Feed for
Source from the software application, and then select the
correct paper size and type. For details, see page 4.6.

Note: Please be careful when you open the rear cover. The inside
of the printer maybe hot.

4 Press the Cancel button to start feeding. Printing is started.
Close the rear output tray after the printing is completed.

Note: To prevent labels from sticking to each other, do not let the
printed label sheets stack up as they are printed out.

Printing on Transparencies

Guidelines

¢ Only use transparencies recommended for use in laser
printers.

¢ Ensure that transparencies are not wrinkled, curled, or have
any torn edges.

e Hold the transparencies by the edges and avoid touching the
print side. Qils deposited on the transparency can cause print
quality problems.

e Be careful not to scratch or leave fingerprints on the print
side.

1 Open the rear output tray. Load transparencies in the
manual feeder with print side up, and the top with the

adhesive strip going first.
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2 Adjust the guide to fit the width of the transparencies.

3 When you print on transparencies, you must select Manual
Feed for Source from the software application, and then
select the correct paper size and type. For details, see
page 4.6.

gNote: Please be careful when you open the rear cover. The inside
of the printer maybe hot.

4 Press the Cancel button to start feeding.
Printing is started. Close the rear output tray after the
printing is completed.

d Notes:

¢ To prevent transparencies from sticking to each other, do not let
the printed sheets stack up as they are printed out.

» Place transparencies on a flat surface after removing them from
the printer.
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Printing on Card Stock or
Custom-sized Materials

Postcards, 3.5 by 5.83 in.(index) cards and other custom-sized
materials can be printed with this printer. The minimum size is
76 by 127mm(3.0 by 5.0 in.) and the maximum size is 216 by
356mm(8.5 by 14 in.).

Guidelines

¢ Always insert the short-edge into the Manual Feeder first. If
you want to print in landscape mode, make this selection
through your software. Inserting paper long-edge first may
cause a paper jam.

¢ Do not print on media smaller than 76mm (3.0 in.) wide or
127mm(5.0 in.) long.

o When you print on 76mm x 127mm sized media with loading
into the tray, open the rear output tray.

1 Open the rear output tray. Load print material with print
side up, short edge first and against the left edge of the
feeder.

2 Adjust the guide to fit the width of the material.
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3 When you print on card stocks or the custom-sized paper,
you must select Manual Feed for Source from the
software application, and then select the correct paper size
and type. For details, see page 4.6.

Note: If the size of your print material is not listed in the Size box
in the Paper tab of the printer driver properties, click Add
Custom button and set the size manually. See page 4.6.

4 Press the Cancel button to start feeding.
Printing is started. Close the rear output tray after the
printing is completed.

Printing on Preprinted Paper

Preprinted paper is paper that has some type of printing placed
on it before it is sent through the printer (paper that has a
preprinted logo at the top of the page, for example).

Guidelines

o Letterheads must be printed with heat-resistant ink that will
not melt, vaporize, or release hazardous emissions when
subjected to the printer’s fusing temperature of 400 °F
(205 °C) for 0.1 second.

e Ink on letterheads must be non-flammable and should not
adversely affect any printer rollers.

e Forms and letterheads should be sealed in a moisture-proof
wrapping to prevent changes during storage.

e Before you load preprinted paper as forms and letterheads,
verify that the ink on the paper is dry. During the fusing
process, wet ink can come off preprinted paper.

Note: Please avoice using carbon paper because it may cause the
printer a mechanical trouble.
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1 Load letterheads into the tray you want to use, as shown in
the figures below. Adjust the guides to fit the width of the
paper stack.

Load with the design face
down, bottom edge
towards the printer.

Load with the design face
up, top edge towards the
printer.

2 When you print, configure the paper source, type and size
properly in the software application. For details, see
page 4.6.
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Printing Tasks

This chapter explains the printing options and common
printing tasks.

This chapter includes:

e Printing a Document

e Setting Paper Properties

e Using the Toner Save Mode

e Printing Multiple Pages on One Sheet of Paper (N-
Up Printing)

e Scaling Your Document

e Fitting Your Document to a Selected Paper Size
e Printing Posters

e Setting Graphic Properties

e Printing Watermarks

e Printing Overlays

e Using the Status Monitor

e Setting Up Locally Shared Printer



4.2

PRINTING TASKS

Printing a Document

The following procedure describes the general steps required for
printing from various Windows applications. The exact steps for
printing a document may vary depending on the application
program you are using. Refer to the User’s Guide of your
software application for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is

displayed (It may look slightly different depending on your
application).

The basic print settings are selected within the Print
window. These settings include the number of copies and
print range.

Make sure that your

R ) inter is selected.
— Printer —
vI Properties |

P ame: S amsung ML-1710 S eries

Statug: Default printer; Ready
Type: Samsung ML-1710 Series

“Where:  LPTT:
Comment: Samzung ML-1710 Series ™ Printta file
— Print range Copie:
= Al Mumber of copies: |1 3:
" Pages from |1 o
i
) SElention

ak I Cancel |

3 To take advantage of the printer features provided by your
printer, click Properties in the application’s print window
and go to step 4.

If you see Setup, Printer, or Options, click that button
instead. Then click Properties in the next screen.



4 Now you see the Samsung ML-1710 series Properties
window, which allows you to access all the information you
will need when using your printer.

The Layout tab is first displayed.

% Samsung ML-1710 Series Properties

Layout I Paper I Graphicsl Extraz I About I

— Orientation
3 B
Q g ‘I:;nds;ape ‘
Rotate I~ =l Degees
The preview image
- Lavout Optians——— " shows the sample page

Type |_Mu|tip|, with the settings you DD

Pages per Side currently specified.

Letter
2.50 x 11.00 in.
Copies: 1
Resolution: Normal

Page Order I j
= Erirt Fage Barder

r— Favorites

|<Unnamed> j

Save |

ak. I Cancel | Apnly | Help |

If necessary, select the Orientation option.

The Orientation option allows you to select the direction in
which information is printed on a page.

ePortrait prints across the width of the page, letter style.
eLandscape prints across the length of the page, spreadsheet
style.

sRotate allows you to rotate the page in the selected degrees.
You can select 0 or 180 degrees.

A Landscape A Portrait

5 From the Paper tab, select the paper source, size and type.
For further details, see page 4.6.

6 Click other tabs on the top of the Samsung ML-1710 series
Properties window to access other features, if needed.
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7 When you complete setting the properties, click OK until
the Print window is displayed.

8 Click OK to start printing.

g Notes:

e Most Windows applications will override settings you specify in
the printer driver. Change all print settings available in the
software application first, and change any remaining settings
using the printer driver.

e The settings you change remain in effect only while you are
using the current program. To make your changes
permanent, make them in the Printers folder. Follows this
procedure.

1 Click the Windows Start button.

2 For Windows 9x/Me/2000/NT, select Settings, and then
Printers.
For Windows XP, select Printers and Faxes.

3 Select the Samsung ML-1710 Series printer.

Click the right mouse button on the printer icon and:
¢ In Windows 9x/Me, select Properties.

¢ In Windows 2000/XP, select Printing Preferences.
¢ In Windows NT, select Document Defaults.

5 Change the settings on each tab, and click OK.

Canceling a Print Job

There are two ways to cancel a print job.

To stop a print job from the Control Panel

Press the Cancel button on the control panel.
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Favoites

|<Unnamed>

Save

The printer will finish printing the page that is moving through
the printer and delete the rest of the print job. Pressing Cancel
cancels only the current job in the printer. If more than one print
job is in the printer memory, Cancel must be pressed once for
each job.

To stop a print job from the Printers folder
1 From the windows Start menu, select Settings.

2 Select Printers to open the Printers window, and double-
click the Samsung ML-1710 Series icon.

3 From the Document menu, select Cancel Printing
(Windows 9x/Me) or Cancel (Windows NT 4.0/2000/XP).

Using a Favorite Setting

The Favorites option, which is visible on each properties tab,
allows you to save the current properties settings for future use.

To save a Favorites item:
1 Change the settings as needed on each tab.
2 Enter a name for the item in the Favorites input box.

3 Click Save.

To use a saved setting, just select the item from the Favorites
drop down list.

To delete a favorite setting item, select the desired item from
the list and click Delete.

You can also restore the printer driver’s default settings by
selecting Printer Default from the list.
Using Help

This printer has a help screen that can be activated by the Help
button in the printer’s properties window. These help screen
give detailed information about the printer features provided by
the printer driver.

You can also click from the upper right hand corner, and then
click on any setting.
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Setting Paper Properties

Use the following options to set the basic paper handling needs
when you access the printer properties. See page 4.2 for more
information on accessing printer properties.

Click the Paper tab to access various paper properties.

&% Samsung ML-1710 Series Properties HE
Lapaut  Paper | Graphicsl Exfras | About |
Copies =1 [1-339
© oo [ —EE
Faper Option:
’@ Size:
|Letter (85:11.01n) =l
Add Custarn |
Source Letter
850 x 11.000n
IAulU Select j B
Rezalution: Mormal
Type ~Favorites———————————————
I Printer Default j I(Unnamed> A
Save |
ELECTRONICS
ak. I Cancel | Apply | Help |

Copies allows you to choose the number of
copies to be printed. You can enter up to
999.

O

Copies

W (1-939)

Size option allows you to choose the size of
paper you loaded into the tray.

@

Size
[Letter 1B.5611.0in) =l

If the required size is not listed in the Size
box, click Add Custom. When the Custom
Page Size window appears, set the paper
and click OK. The size setting appears in the
size list so that you can select it.

Erwelope #10 (4.1:9.5in )
Erwelope DL [4.3%8.7 in]
Envelope C5 (6.4x3.0in.]
Enwelope CE [4.56.4 in.]
Enwelope BS [£.9:3.81n)
Envelope Monarch [3.947.5 in |

2lx

Custom Page Size

4

Double Post Card
8.5:10.0

dd ek e
L Custom N Enter the custom
<Application Custam Paper> name you wa nt
to use.

- Page Dimension;
“wfidth

l__l- 30-85
.50 _~|[ in]

Height

11.00 _lj [5.0-14.00n]
Inches E

0k | Concel | Heb

Enter the paper
size.




©

Source

[uto Select =l
Manual Feed

Make sure that Source is set to the
corresponding paper tray.

Manual Feed source is used when you use
the Manual Feeder to print using special
materials. You have to load one sheet at a
time into the the printer. see page 3.8.

If the paper source is set to Auto Select,
the printer automatically selects paper
from the Manual Feeder first and then from
the Tray.

Type

Card Stock
Labels
Tranzparency
Envelope

Make sure the Type is set to Printer
Default. If you load a different type of
print materials, select the corresponding
paper type. For further information on print
materials, refer to chapter 3 "Using Print
Materials".

If you use cotton paper, set the paper type
to Thick for the best printing.

To use recycled paper, which weights from
20lb to 24lb, or other colored paper, select
Color Paper.
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Using the Toner Save Mode

Toner Save mode allows the printer to use less toner on each
page. Selecting this option will extend the life of your toner
cartridge and reduce your cost per page, but will reduce print
quality.

There are two ways to enable the Toner Save mode:

From the Control Panel

Press the Cancel button on the control panel. The printer must
be in Ready mode (On Line/Error green LED is on).

¢ If the Toner Save LED is on, the mode is enabled and the
printer uses less toner to print a page.

¢ If the Toner Save LED is off, the mode is disabled and the
printer prints in the normal mode.



From the software application

1 To change the print settings from your software application,
access the printer properties. See page 4.2.

2 Click the Graphics tab, and select the Toner Save option.
You can select from:

sPrinter Setting: If you select this option, this feature is
determined by the setting you’ve made on the control
panel of the printer.

*On: Select this option to allow the printer to use less toner
on each page.

*Off: If you don’t need to save toner to print a document,
select this option.

% Samsung ML-1710 Series Properties

Layout | Paper  Graphics | Entras | About |

— Resalution
S €300 dpi
| oher Save
N & Printer Setting
2=y O On
[ i
Letter
8.50 x 11.000in.
Copies: 1
Resolution: Normmal
~ Favorites
|<Unnamed> j
Advanced Options | Save |

Phinsunng

ELECTRONICS

aK I Cancel | Apply | Help |

3 Click OK.
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Printing Multiple Pages on One
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of
paper. To print more than one page per sheet, the pages will
appear decreased in size and arranged on the sheet. You can
print up to 16 pages on one sheet.

1 To change the print settings from your software application,
access the printer properties. See page 4.2.

2 From the Layout tab, choose Multiple Pages per Side in
the Type drop-down list.

3 Select the number of pages you want to print per sheet (1,
2,4, 9o0r 16) in the Pages per Side drop-down list.

@ Samsung ML-1710 Series Froperties

Layout I Paper | Graphicsl Extras | About |

— Orientation
} ' Portrait
4] Landscape
Reb=t o _'I Degrees
- Layout Optiok —
Type IMuItipIe Pages per Side ;-[
Fages per Side -
A
Fage Order IHight, Then Down j 2.27 x 1169 in.
Copies: 1
™ Frint Fage Border Resolution: Mormal

~ Favorites
|<U nnamed> ﬂ

Save |

QK. I Cancel | Apply | Help |

Check Print Page Border to print a border around each
page on the sheet. Print Page Border is enabled only if
the Pages per Side is 2, 4, 9, or 16.
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4 Select the page order, if necessary.

Right then Down then Left then Down then
Down Right Down Left

5 Click the Paper tab, select the paper source, size and type.

6 Click OK and print the document.
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Scaling Your Document

You can scale your print job on a page.

1 To change the print settings from your software application,
access the printer properties. See page 4.2.

2 From the Layout tab, select Reduce/Enlarge in the Type
drop-down list.

3 Enter the desired scaling rate in the Persentage input box.

You can also click the A or ¥ button.

&% Samsung ML-1710 Series Properties

Lapout | Faper I Graphicsl Extras I About I

— Orientation
] I & Portrait
4| ¢ Landscape

riotate ] ;: Negrees

— Layout Option: —

Type I Feduce/Enlarge L’ Dl:l

Persentage Igg _I; [25 - 400%)

A
227 x 116900,
Copies: 1
Resolution: Normal

— Favorites

|<U rinamed: j

Save |

e

ELECTRONICS

0k I Cancel | Apply | Help |

4 Click the Paper tab, select the paper source, size and type.

5 Click OK and print the document.
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Fitting Your Document to a Selected
Paper Size

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size. This
can be useful when you want to check fine details on a small
document.

1 To change the print settings from your software application,
access the printer properties. See page 4.2.

2 From the Layout tab, select Fit to Page in the Type drop-
down list.

3 Select the correct size from the Target Paper drop-down
list.

@ Samsung ML-1710 Series Properties

Layout | Paper | Graphicsl Extras | About I

— Orientation
E I & Poitrait
a Landscape
Rotate IU vI Ly, ==
— Layout Option: ol
Type IFit to Page j
Target Page fe
A
827 x 1168 0n.
Copiez: 1
Resalution: Normmal
— Favorites
<Unnamed: j
Save |

ak I Cancel Apply | Help I

4 Click the Paper tab, select the paper source, size and type.

5 Click OK and print the document.
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Printing Posters
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This feature allows you to print a single-page document onto 4,
9, or 16 sheets of paper, for the purpose of pasting the sheets
together to form one poster-size document.

To change the print settings from your software application,
access the printer properties. See page 4.2.

Click the Layout tab, select Poster in the Type drop-down

list.

@ Samzung ML-1710 Series Properties

Layout | Paper I Graphicsl Extras I About I

r— Oientation
1 I & Poitrait
B Landzcape
Tiutate ID_ 5 Magrees
Layout Option
T‘Irlpe R L
all
Page Layaut I 4P - l
. Letter
Dverlap 015 = (0.01-1.00n] 8.50 x 11.00 in.
Copies: 1
Ilnches VI Rezolution: Mormal
- Favorites
<Unnamed: j
Save I
ELECTRONICS
QK. I Cancel Apply | Help |

3 Configure the poster option:

You can select the page layout from 2x2, 3x3, or 4x4. If you
select 2x2, the output will be automatically stretched to

cover 4 physical pages.

\@

8,

%)

i 5

A2x2 A3x3



Specify an overlap in millimeter or inch to make it easier to
reconstruct the resulting poster.

| |+ |~ 0.15inch

|
N i

-
0.15inch

4 Click the Paper tab, select the paper source, size and type.

5 Click OK and print the document. You can complete the
poster by reconstructing the results.
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Setting Graphic Properties

Use the following Graphic options to adjust the print quality for
your specific printing needs. See page 4.2 for more information
on accessing printer properties.

Click the Graphics tab to display the properties shown below.

@ Samsung ML-1710 Series Properties

La_l,JoutI Paper  Graphics | Extraz I About I

Rezolution

—

ﬂ 300 dpi [Draft)

i

@TonerSa E

-, & Prinker 5etling
‘.’-Sr'\-{ " On
i
Letter
250 = 11.00 in.
Copies: 1
Resolution: Mormal
— Favorites
|<Unnamed> j
@ Advanced Options | Save |
ﬂ ELECTRONICS
ak. I Cancel | Apply | Help |

0]

Resolution

You can select the printing resolution by
choosing from 600 dpi (Normal) or 300
dpi (Draft). The higher the setting, the
sharper the clarity of printed characters and
graphics. Higher settings may increase time
it takes to print a document.

@

Toner Save

Selecting this option will extend the life of
your toner cartridge and reduce your cost per
page without a significant reduction in print
quality. For detailed information about this
mode, see page 4.8.




® You can set advanced settings by clicking the
Advanced Options button.

Adv-a nced Advanced Options i ES
Options ~Darkne

™ Darken Text

— TrueType Option;
A & Download as Bit Image
" Print as Graphics

™ Prirt &1l Test Black,

Ok I Cancel Help

Darkness

Use this option to lighten or darken the image
appearance in your print.

¢ Normal: This setting is for normal
documents.

¢ Light: This setting is for bolder line widths or
darker gray-scale images.

¢ Dark: This setting is for finer line width,
higher definition in graphics, and lighter gray-
scale images.

When the Darken Text option is checked, all

text in your document is allowed to print darker

than a normal document.
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